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1. Version Management

Version Update Description Table

Version Content Date
V1.3 1. Added: Include a chapter on Using the Accompanying Trigger 02/05/2026
Board

2. Added: 10 MHz Reference Clock Input/Output Section
Added: External Interface Description section for the All-New
SAN Series Instruments
4. Added: GNSS Usage Section for the All-New SAN Series
Instruments
Added: GPIO Usage Instructions Section
Modified: Renamed MUXIO to AUXIO 11/10/2025
Modified: Description modification
Added: Added a GNSS version description section, 09/04/2025
distinguishing the connection steps for the old and new GNSS

V1.2

=N Sa

Vi1

modules
2. Added: Added a section on outputting and Viewing the
Intermediate Frequency Signal
3. Added: Added: a section on OTG Connection
V1.0 1. Initial Version 07/30/2025
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2. System requirements

SA/NX series are core instruments, and their spectrum analysis software must be installed on
a host computer. The recommended host system requirements are listed in the table below:

The table provides only basic recommended configurations. For systems below these
specifications, please verify with actual test results.

Table 1 System Requirements

Operating System Windows 11/10/8/7, (requires V52019 C++ redistributables)

Architecture

Processor

Memory

Storage

Data Interface

Display
Other Notes

Ubuntu 22.04/20.04/18.04, Debian 12/11/10, Raspberry Pi OS 64bit
Windows: x64, AArch64 (NX instruments only)

Linux: x64, AArch64

Windows: Intel i3 or higher; AArch64 tested only on Snapdragon 8CX
Gen2

Linux: Tested on Raspberry Pi 4B, PK3399, PK3588, etc.
4 GB or higher

For 1Q signal recording: Ensure sustained write speeds exceed 400
MBytes/s

USB 2.0 or USB 3.0 (USB 3.0 recommended)

|Q recording bandwidth and duration are limited by interface bandwidth

Minimum resolution: 1280x800 pixels

Some antivirus software may cause system instability

Spectrum Analyzer Quick Start Guide 2



3. SA Series Quick Start Guide

This chapter is a quick start guide to the SA Series, featuring safety instruction, using
instruments, running the software and external interface description.
3.1 Safety Instruction

311 Power Adapter Selection

1. Adapter Option: Always use the original manufacturer-provided power adapter. Alternative:
If unavailable, select a compatible adapter with specifications matching those outlined in
the product manual.

2. DC power supply requirements: voltage: 5V + 0.25 V (4.75 V to 5.25 V), current: minimum 2
A (3A for the all-new SAN series); peak ripple maximum 200 mVpp.

I, Violation of specifications may result in damage to the instrument, follow the product

manual strictly.

3.1.2 RF Input

For maximum damage input power (CW) and maximum DC voltage, please refer to the product
manual, and strictly prohibit exceeding the limits to avoid irreversible damage to the instrument.
3.2 Using SA Series Instruments

3.2.1 Connecting the Device

1. Connecttheinstrument's power port to the power adapter using the Type-C cable and plug
it into the socket;

2. Connect the instrument's data port to a computer or embedded device using a Type-C
cable, USB 3.0 is recommended for best performance.

Note: It requires for 3 seconds for SA Series instruments operating normally after power-on.

Soee SAN-400 won

Figure 1 SA series connection diagram

3.2.2 Driver Installation (Windows)

The following part presents the instructions for driver installation using Windows 10 x64 as an
example. Note: Windows 11 is compatible with Windows 10 drivers.

1. Check the computer system information, confirm the system version and number of bits;
2. Open the "Windows\HTRA_Driver\Win10_x64" folder in the supplied USB flash;

Spectrum Analyzer Quick Start Guide 3



Right-click the "Install_Driver.bat" file and select "Run as administrator" from the pop-up
menu to initiate driver installation;

Y CYUSB2.sys 1/12/2024 12:38 AM

# htra_ushdriver.cat 1712720241
. HTRA_USBDriver.inf 1/12/2024 12:38 AM
1/12/2024 12:38 AM

&% @O @ B W

[®] QOpen Enter

= Share

) Run as administrator

1% Add to Favorites

Figure 2 Installation of driver
The terminal appears "USB Driver Installation Succeeded" prompt, it means that the driver
installation success.

3.2.3 Driver Installation (Linux)

The following will be an example of installing the driver in Ubuntu 18.04.

1.
2.

Copy the "Linux" folder from the supplied USB flash to the system;

Right-click on the "Linux/Install_HTRA_SDK" folder and select "Open in Terminal" to open
the terminal;

In the terminal type sudo sh install_htraapi_lib.sh and enter, according to the prompts to
enter the current user password, and then enter again to confirm the installation;

After connecting the instrument, type Isusb in the terminal, such as 1D:6430, ID:04b5 or
ID:367f, it means the driver installation is successful.

xy@ubuntu: ~/Desktop

s S lsusb

Device 002: ID 367f:0001 HTRA HTRA

Device 001: ID 1d6b:0003 Linux Foundation 3.0 root hub

Device 002: ID 0e06f:0003 VMware, Inc. Virtual Mouse

Device 001: ID 1d6b:0002 Linux Foundation 2.0 root hub

Device 001: ID 1d6b:0002 Linux Foundation 2.0 root hub

Device 003: ID 0e0f:0002 VMware, Inc. Virtual USB Hub

Device 002: ID 0e0f:0008 VMware, Inc. Virtual Bluetooth Adapter
Device 001: ID 1d6b:0601 Linux Foundation 1.1 root hub

Figure 3 Checking Whether the Instrument Is Properly Connected in Linux

3.3 Running the Software

3.31 Windows System

By default, the instrument is properly connected and the driver is installed.

1.

Copy the software folder in the "Windows" directory of the supplied USB flash drive to the
desktop or other directories of your computer;

Enter the "\bin" folder in the software directory, run the executable program, and the
spectrum display interface will be as follows.

Spectrum Analyzer Quick Start Guide 4



Figure 4 Initial software display

3.3.2 Linux System

By default, the instrument is properly connected and the driver is installed. GCC version 4.8 or

above. GLIBC version 2.17 or above.

1.

Copy the compressed package of the software for the corresponding architecture from
the supplied USB flash drive to the Linux system and extract it;

Navigate to the directory containing the software installation package, right-click on a
blank area of the folder, and select “Open in Terminal”;

In the terminal, run sudo sh ./install.sh, then enter the password as prompted to complete
the installation;

After installation is complete, double-click the desktop software icon or enter ./app.sh in

the terminal to launch the software.
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3.4 External Interface Description

3.41 SAN Series and SAM Series

SAM-GO M3 6.3GHz

) Real-Time Spectrum Analyzer
®) FPGA based DSP

Figure 5 SAN and SAM Series Instrument Interface Description
Table 2 SAN Series and SAM Series Interface Description

Pin Interface Name Description

1 RF Input SMA (F), Input Impedance 50 O

2 RF Output SMA (F), Output Impedance 50 Q (Available with "Built-
in Signal Source" option)

3 Reference Clock Input ~ MCX (F), Amplitude = 1.5 Vpp, Input Impedance 330 Q.
Supports Sine, Square, Peak Clipping Sine

4 Power Port Instrument Charging Port, Type-C5V2A

5 Data Port Type-C, USB 3.0 Recommended (USB 2.0 compatible,
but bandwidth limited)

6 Multifunctional AUXIO  For detailed description, please refer to the table below.

Table 3 Description of Multi-function AUXIO PIN Interface of Port 6 (lllustration direction
from left to right)

Pin Name Direction Level Standard Meaning

A1 GND / / Ground

A2 NC / / /

A3 EXT_TRG-IO1_F I 3.3V External trigger input,
up to 500 times/s.

A4 VEXT O / Power Output, 5V

A5 GND / / Ground
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A6 USART6_TX_F / / /

A7 USART6_RX_F / / /

A8 NC / / /

A9 VEXT O / Power Output, 5V

A10 EXT_TRG-102_F O 3.3V External trigger
output

AN USARTG6_IT_F / / Reserved

A12 GND / / Ground

3.4.2 SAE Series and SAN-400 Series

‘.‘ SAE-200 200

" Re rum Analyzer
" Fp

23dBm MAX (>50MHz and AMP Off)
10dBm MAX (550MHz or AMP On)
12VDC MAX

Figure 6 SAE and SAN-400 series instrument interface description

Table 4 SAE Series and SAN-400 Interface Description

Pin Interface Name Description

1 RF Signal Input SAE-90 series instruments: SMA (F), input impedance 50 Q
SAE-200/SAN-400 series instruments: 2.92 mm (F), input
impedance 50 Q)

2 Analog IF output MMCX (F), maximum output power -25 dBm, output
impedance 50 Q

3 Reserved interface ,

4 Reference Clock MMCX (F), Amplitude = 1.5 Vpp, Input Impedance 330 Q

Input Supports Sine, Square, Peak Clipping Sine
5 Multifunctional

For detailed description, please refer to the table below.
AUXIO

Spectrum Analyzer Quick Start Guide 7



8

Heat dissipation

vent

Data port Type-C, USB 3.0 Recommended (USB 2.0 compatible, but
bandwidth limited)

Power port Instrument Charging Port, Type-C5V 2 A

Table 5 Description of Multifunctional AUXIO PIN Interface of Port 5 (lllustration direction
from left to right)

Pin

Name Direction Level Standard Meaning

EXT_TRG_IO1 | 3.3V Trigger input, up to 500 times/s
EXT_TRG_IO2 / / Reserved

EXT_TRG_IO3 O 3.3V Trigger output

GND / / Ground

LFADC_INA I / Low Frequency ADC Input
3V3D O / Power output, 3.3 V Output
USART9_RX / / /

GND / / Ground

USART_TX / / /

NC / / /

NC / / /

NC / / /

GND / / Ground

REFCLK_OUT O / Reference clock output, can

output 10 MHz standard clock
signal

Spectrum Analyzer Quick Start Guide 8



3.4.3 All-New SAN Series

SAN-90

9 kHz-9 GHz

um Analyzer

RFIN50Q i
™ CED) - @D - e
® ) D POWER DATA AUXIO

A 23 dBm MAX (> 50 MHz and AMP Off)
* A10 dBm MAX (=50MHz or AMP On)

Figure 7 All-New SAN series instrument interface description
Table 6 All-New SAN Interface Description

Pin Interface Name Description

1 RF Signal Input N (F), impedance 50 Q

2 GNSS Antenna Input SMA (F)

3 Power Port Instrument Charging Port, Type-C5V 3 A

4 Data Port Type-C, USB 3.0 Recommended (USB 2.0 compatible,
but bandwidth limited)

5 Reference Clock Input MMCX (F), 10 MHz, Amplitude = 1.5 Vpp, Impedance
330 Q), Supports Sine, Square, Peak Clipping Sine

6 Reference Clock Output MMCX (F), 100 MHz, Amplitude = 0.3 Vpp,
programmable on / off

7 Analog IF output MMCX (F), maximum output power -25 dBm, output
impedance 50 Q, frequency 312.5 MHz + 50 MHz

8 Multifunctional AUXIO For detailed description, please refer to the table

below.
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Table 7 Description of Multifunctional AUXIO PIN Interface of Port 8 (lllustration direction
from left to right)

Pin

1

N

© 0 N oo g h~ N

12

13

14

Name

TRGIN

TRG OUT
Reserved
GND

PPS OUT
3.3V
USRAT RX
GND
USART TX
Reserved
Reserved
Reserved
GND

Reserved

Direction

N N N N N O N

Level Standard Meaning

3.3V

3.3V

3.3V
3.3V

3.3V

3.3V

NN N NN

Trigger  input, maximum
frequency response 500
times/s.

Trigger output
Reserved
Ground

XPPS output
Power output, 3.3 V output
/

Ground

/

Reserved
Reserved
Reserved
Reserved

Reserved
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4. NX Series Quick Start Guide

This chapteris a quick start guide to the NX Series, featuring safety instructions, instrument use,
runtime software and external interface descriptions.
41 Safety Instructions

411 Power Adapter Selection

1. Primary Option: Always use the original manufacturer-provided power adapter. Alternative:
If unavailable, select a compatible adapter with specifications matching those outlined in
the product manual.

2. DC power supply requirements: voltage: 12V (9 V to 12 V), current: minimum 2 A; peak ripple
maximum 200 mVpp.

I, Violation of specifications may result in damage to the instrument, follow the product
manual strictly.

41.2 RF Input

For maximum damage input power (CW) and maximum DC voltage, please refer to the product
manual, and strictly prohibit exceeding the limits to avoid irreversible damage to the instrument.
4.2 Using the NX Series Device

4.21 Connecting the Device

1. Connect the instrument's power port to the power adapter using the Type-C cable and plug
it into the socket.

2. Use a network cable to connect the Gigabit network port (LAN2) of the instrument to the
network port of the computer or embedded device for optimal performance (100 Mbps for
LAN1 and 1 Gbps for LAN2).

Note: NX series instruments need about 40 s to complete the self-start after power on, please

wait patiently. Long press the power button for more than 5 seconds to switch off the

instrument.

Figure 8 NX series connection diagram

Spectrum Analyzer Quick Start Guide 11



4.2.2 Configuring the Network

NX Series Instrument Network Configuration Instructions:

= |Pv4 address: "192.168.1.100" (not modifiable), "192.168.3.100" (modifiable)

»  Subnet mask: "255.255.255.0"

= Bridge mode: enabled (LAN1/LAN2 logical interworking)

=  Network access: via LAN1 (100 Mbps) or LAN2 (1 Gbps)

The host computer needs to set the IP of the same network segment as the NX instrument (e.g.

"92.168.1.X" or "92.168.3.X") in order to be used normally, and the IP address of the host

computer can be configured as follows:

1. Open "Settings" -> select "Network & Internet" -> select "Ethernet";

2. Enter Ethernet, find the IP section and click "Edit";

3. Select "Manual" mode and enable "IPv4", set the IP to "192.168.1.2" and the subnet mask to
"255.255.255.0". Set the IP to "92.168.1.2" and subnet mask to "255.255.255.0"

4. Openthe command prompt (Win + R -> enter "cmd"), the implementation of the command
"ping 192.168.1.100", if you receive the following reply, it means that the network connection
is successful.

T CAWINDOWS\system3Z\emd. X + -~

Microsoft Windows [Version 10.0.22631.4037]
(c) Microsoft Corporati ALl rights reserved.

C:\Users\16418>ping 192.168.1.100

Figure 9 Test instrument network connectivity (ping command)
4.3 Running the Software
Please refer to the Running the software section in SA Series Quick Start Guide chapter.
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4.4 External Interface Description

4.41 NXN and NXM Series

Figure 10 NXN and NXM Series Instrument Interface Description
Table 8 NXN Series and NXM Series Interface Description

Pin

1

N o o b~ A

11213
9

10

14

Interface Name

Reference Clock Input

RF Output

RF Input

uUsB

GNSS antenna input
Trigger output
Trigger input

Reference Clock Output

Reserved Interface
Multifunctional AUXIO
4G Antenna Input

Instrument Switch

Description

MCX (F), Amplitude =1.5 Vpp, Input Impedance 330 Q.
Supports Sine, Square, Peak Clipping Sine

SMA (F), Output Impedance 50 Q (Available with "Built-
in Signal Source" option)

SMA (F), input impedance 50 Q

Type-C, USB 2.0
MMCX (F)
MMCX (F), 3.3V CMOS

MMCX (F), 3.3V CMOS, high-impedance input, max
trigger rate 500 times/s

Provides high quality 10 MHz clock signal when
equipped with internal DOCXO

/

For a detailed description, please refer to Table below.
MMCX (F)

Switch the instrument on/off. The instrument starts up
automatically on first power-up, eliminating the need

Spectrum Analyzer Quick Start Guide 13



to manually press the switch. During power-up, the
instrument can be switched off and on again with a

switch.
15 Reserved Interface /
16 Power Port Type-C PD3.012V2A/9V2A
17 LAN1 Fast Ethernet Port (100 Mbps)
18 LAN2 Fast Ethernet Port (1 Gbps)

Table 9 Description of Multifunctional AUXIO PIN Interface of Port 9 (lllustration direction
from right to left)

Pin Name Direction Level Standard Meaning

1 GPIOO / / Reserved

2 TRG 102 / / Reserved

3 GPIO1 / / Reserved

4 GND / / Ground

5 GPIO2 / / Reserved

6 3V3/5VIN O / Power output, 5 V output
7 GPIO3 / / Reserved

8 GND / / Ground

9 USART_TX_FP / / Reserved

101112 NC / / /

13 GND / / Ground

14 REFCLK_OUT_FP O / Reference Clock Output,

Outputs 10 MHz std. clock

Spectrum Analyzer Quick Start Guide 14



4.4.2 NXE Series and NXN-400

Figure 11 NXE and NXN-400 series instrument interface description
Table 10 NXE and NXN-400 Series Interface Description

Pin

o o0 M W

~

10,11
12

13
14

Interface Name

RF Input

USB

Multifunctional AUXIO
GNSS Antenna Input
Trigger Output
Trigger Input

Reference Clock Input

4G Antenna Input
Analog IF Output

Reserved Interface

Instrument Power
Switch

Reserved Interface

Power Port

Description

NXE-90 series instruments: SMA (F), input impedance 50 Q
NXE-200/NXN-400 series instruments: 2.92 mm (F), input
impedance 50 QO

Type-C, USB 2.0

For detailed description, please refer to the table below.
MMCX (F)
MMCX (F), 3.3V CMOS

MMCX (F), 3.3V CMOS, high-impedance input, max trigger
rate 500 times/s

MMCX (F), Amplitude = 1.5 Vpp, Input Impedance 330 Q.
Supports Sine, Square, Peak Clipping Sine

MMCX (F)

MMCX (F), Max Output Power -25 dBm, Output Impedance
500
/

Switch the instrument on/off. The instrument starts up
automatically on first power-up, eliminating the need to
manually press the switch. During power-up, the
instrument can be switched off and on again with a switch.
/

Type-CPD3.012V2A/9V2A
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15 LAN1 Fast Ethernet Port (100 Mbps)
16 LAN2 Fast Ethernet Port (1 Gbps)

Table 1M Pin 3 Multi-function AUXIO Pin out Description (Pins ordered right-to-left in
diagram)

Level

Pin Name Direction Standard Meaning

1 GPIOO / / Reserved

2 TRG 102 / / Reserved

3 GPIO1 / / Reserved

4 GND / / Ground

5 GPIO2 / / Reserved

6 3V3/5VIN O / Power Output, 3.3V Output
7 GPIO3 / / Reserved

8 GND / / Ground

9 USART_TX_FP / / Reserved

10 SYNC_RXRFLO / / Reserved

1 SYNC_ADCCLK  / / Reserved

12 SYNC_RXIFLO / / Reserved

13 GND / / Ground

14 REFCLK_OUT_FP O / Reference Clock Output, Outputs

10 MHz std. clock

Spectrum Analyzer Quick Start Guide 16



5. PX Series Quick Start Guide

This chapter is a quick start guide to the PX Series, featuring safety instructions, instrument use
and external interface descriptions.
5.1 Safety Instruction

51.1 Safety Rules

» Appearance check: make sure that the instrument is in good condition and free from
damages
=  Accessory check: no damage to power cord, adapter
= Ventilation check: fan vents are kept clear
» Environment check: the instrument is dry and free of moisture and condensation, and the
ambient temperature meets the requirements of the product specification
»  Operation monitoring: Ensure that the fan is working properly and that the working
temperature and humidity are in accordance with the product specifications
» Connection specification: all external interfaces are correctly connected and the RF input
signal level meets the requirements of the product specification
» Power management: maintains battery at >5% of capacity
» Storage requirements: the instrument is completely switched off, and the temperature and
humidity of the storage environment meets the requirements of the product specification
1. Abnormal handling: Any damage or malfunction is found, please contact the official after-
sales service in a timely manner
i Safety warning: It is strictly forbidden to open the shell of the instrument (to prevent electric
shock)

5.1.2 Power Adapter Selection

Adapter Selection: Prefer the original matching power adapter. Alternative: Refer to the
product manual to select the adapter with matching specifications.
. PXZ instruments must use the original factory-mounted power adapter; third-party
alternatives are not supported.
I Violation of specifications may result in damage to the instrument, follow the product
manual strictly.

5.1.3 RF Input

For maximum damage input power (CW) and maximum DC voltage, please refer to the product
manual, and strictly prohibit exceeding the limits to avoid irreversible damage to the instrument.

5.1.4 Replacing the Power Adapter

PX series instruments support the replacement of batteries, if you need to replace, please
contact the official after-sales service channel to deal with, do not disassemble the instrument.
5.2 First Use of the Instrument

The instrument has been transported over along distance, the battery power may be below 5%,
itisrecommended to connect the supplied power adapter before the first use, and then switch
on the instrument.
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5.2.1 Switching the Instrument On and Off

The instrument is switched on/off by the power button on the top of the instrument. When the

instrument is switched on, the power indicator light is on; when it is switched off, the power

indicator light is off.

5.2.2 Charging Indicator

When the instrument is connected to the power adapter, the charging status light flashes green

to indicate that it is charging. When the battery is fully charged, the charging indicator light will

change to a green constant light.

5.2.3 Running the Software

Press the power button, the instrument will enter the desktop environment after powering on

and start the software automatically.
5.3 External Interface Description

5.31 PX Series

All interfaces of the instrument are integrated in the top panel for user-friendly operation,

please refer to Table below detailed description of each interface.

Figure 12 PX series instruments upper board interface description

Table 12 PX Series Interface Description

No

1

2

o g A~ N

Interface Name

Power Button

Charging port

Micro HDMI
USB3
uUsSB2
usB1

Description

On/Off instrument

Instrument charging port, USB PD3.0 20 V 3.25 A, please
connect the power supply according to the
instrument's required operating voltage

For extended display

USB interface: USB3 is USB 3.0 interface, USB1 and
USB2 are USB 2.0 interface. This interface connects to
external storage devices, USB keyboards, or mice. It
can also be used to connect a driver-free Hub with an
Ethernet port, allowing the instrument to be remotely
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controlled by a PC via network cable

7 Audio Output 3.5mm headphone jack. Volume can be adjusted via the
menu: "System" -> "Device" -> "Volume."

8 Multifunctional AUXIO For detailed description, please refer to the table
below.

9 Charging Indicator Green flashing means charging, green always on means
full.

10 Analog IF output MMCX (F), max. output power -25 dBm, output
impedance 50 Q

1" Trigger Output 3.3V CMOS

12 Trigger Input MMCX (F), 3.3V CMOS, high-impedance input, max
trigger rate 500 times/s

13 Reference Clock Input MMCX (F), Amplitude = 1.5 Vpp, Input Impedance 330
Q.
Supports Sine, Square, Peak Clipping Sine

14 GNSS Antenna MMCX (F), amplitude 1.5Vpp, input impedance 330 Q

15 RF Signal Input PXE-200: N (F), input impedance 50 Q

PXN-400: 2.4mm (M), input impedance 50 Q
Table 13 Pin description for AUXIO interface 8 (from left to right)

Level

Pin Name Direction Meaning
Standard
1 GPIOO / / Reserved
2 TRG 102 / / Reserved
3 GPIO1 / / Reserved
4 GND / / Ground
5 GPI102 / / Reserved
6 3V3/5VIN O / Power Output, PXN-400 and
PXE Series 5 V Output
7 GPIO3 / / Reserved
8 GND / / Ground
9 USART_TX_FP / / Reserved
10 SYNC_RXRFLO | 3.3V RF LO synchronization
1" SYNC_ADCCLK | 3.3V ADC clock synchronization
12 SYNC_RXIFLO | 3.3V IF LO synchronization
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13 GND / / Ground
14 REFCLK_OUT_F O / Reference clock output for 10
P MHz standard clock signals

5.3.2 PXZ Series

Please refer to the following table for detailed information on each interface12.

12VDC MAX PXE-200
23dBm MAX (»50MHz and AMP off) O ok
10dBm MAX (sS0MHz or AMP on) Sy R

spowerr D @@ G  «anT ReF Auxo

Figure 13 PXZ series instruments upper board interface description
Table 14 PXZ Series Interface Description

No Interface Name Description
1 RF Signal Input PXE-200 Z: 2.92mm (M), input impedance 50 Q
PXN-400 Z: 2.4mm (M), input impedance 50 Q
2 Charging port Instrument charging port, USB PD (100W)
3 External Antenna Input MMCX (F), amplitude = 1.5 Vpp, input impedance 330 Q
4 Reference Clock Input MMCX (F), Amplitude = 1.5 Vpp, Input Impedance 330 Q.
Supports Sine, Square, Peak Clipping Sine
5 Multifunctional AUXIO For detailed description, please refer to the table below.
6 loudness Increase/decrease instrument volume
7 USB USB3.0 interface. Through this interface to connect the

external expansion memory and USB keyboard, mouse;
or connect the driver-free Hub with network port,
through the network cable to connect to the PC, the PC
to the instrument for remote control

8 SD Card Slot Supports microSD, microSDHC or microSDXC memory
cards for transferring data between the card and the
instrument

9 Charging Indicator Green flashing means charging, green always on means
full.

10 GNSS Indicator Blue indicates GNSS locked
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1" Audio Output

12 Power Button

3.5mm headphone jack. Volume can be adjusted via the
menu: "System" -> "Device" -> "Volume."

Switching the instrument on/off

Table 15 Port 5 Multi-function AUXIO PIN Connector Description (A1-A12 shown from left to
right B1-B12 shown from right to left)

Pin Name

A1/7A12 GND

A2 to A3 /

A5 to A8

A10 to A1

A4/A9 VBUS OUT

B1/B12 GND

B2 REFCLK_OUT
B3 TRG_I02
B4/B9 VBUS OUT
B10 /

B5-B8

B11 EXT_TRGIN

Direction

/

/

Level Standard Meaning

/

/

3.3V

Ground

Reserved

Power supply 5V output
Ground

Reference clock output for 10
MHz standard clock signals
Trigger output, 3.3V CMOS

Power supply 5V output

Reserved

External trigger input, 3.3V
CMOS input impedance is
high resistance, maximum
frequency response 500
times/s.
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6. GNSS Application Instructions

This chapter describes how to identify the version of the accompanying GNSS module and how
to obtain real-time positioning data using either the internal or an external GNSS module.
6.1 Internal GNSS Option

6.1.1Version Information

The internal GNSS module refers to the company’s in-house developed GNSS module, which
is available in two versions: Version A and Version B. Version A is the earlier version, while
Version B is the newer one. The two versions are functionally identical and differ only in their
power supply methods. Please identify the module version in use according to the appearance
diagrams below, and strictly follow the corresponding section for connection and operation to
ensure stable operation of the GNSS module.

Figure 14 GNSS module version A Figure 15 GNSS module version B
appearance appearance

6.1.2 Description of GNSS Options

The following accessories are for SA series instruments. NX/PX/SAN series instruments have
built-in GNSS modules, so to use the GNSS function, you only need to connect the antenna,
and do not need to connect the accessories listed below.

Note: 1PPS and 10MHz clock signal outputs from GNSS are not recommended when the GNSS
module is unlocked.
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i

Version A standard GNSS Version A high-precision GNSS Version A high-quality GNSS
module module module

Version B standard GNSS Version B high-precision GNSS Version B high-quality GNSS

module

Ribbon Cable
(Connection of external GNSS
modules and SA series
instruments)

module module

MMCX-to-SMA Cable AUXIO Multi-Function to Type-C

(Connection of antenna and Adapter
GNSS module) (Connection of SAM/SAN series

and rows of wires)

MCX-to-MMCX Cable MMCX Cable
(Connection of the reference input of the (Connection of the reference input of the
SAM/SAN instrument and the reference output of SAE/SAN-400 instrument and the reference

the GNSS module)

output of the GNSS module)
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6.1.3 Interface Description

External GNSS Antenna Interface

External Reference Input Interface

External Trigger Input Interface

Trigger Output Interface

Analog Intermediate Frequency (IF)

Output Interface (for SAE/SAN-
400 devices)

- T e |

Reserved Interface

Supply Type-C
Interface (only applicable to high-

Auxiliary Power

quality GNSS modules)
AUXIO  Multi-Function
(Trigger Input/Output)

Interface

Analog Intermediate Frequency (IF)
Input Interface (for SAE/SAN-400
devices)

10MHz Reference Clock Output for
High-Quality GNSS Modules
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6.2 External GNSS Module

An external GNSS module refers to a GNSS module produced by a third-party manufacturer
that supports serial communication. Users can connect the serial output of the module to the
instrument PC via a USB-to-serial cable. After the connection is established, the module
communicates with the PC, is recognized by the system as a virtual serial port, and the GNSS
data stream is parsed. Once a successful lock is achieved, GNSS information can be viewed in
the software.

6.3 Connection of Internal GNSS Module

6.3.1 SAE/SAN-400 Series

The operating steps for connecting Version A GNSS option to the SAE/SAN-400 series

instrument are as follows:

1. Instrument connection: Instrument No. 5 AUXIO interface -> GNSS module No. 8 AUXIO
interface (with the ribbon cable), GNSS module indicator light blinking that is connected
successfully.

2. External GNSS antenna connection: antenna -> GNSS module No. 1 interface (with MMCX
to SMA cable), antenna receiving surface towards the unobstructed sky.

3. GNSS external power supply (high-quality modules only): use a Type-C cable to connect
the GNSS module's No. 7 interface to the power adapter and plug it into an outlet.

4. Reference clock connection (high-quality module only): MMCX connector No. 4 of the
instrument -> MMCX connector No. 10 of the GNSS module (with dual-head MMCX cable).

DOST  SAN-200 wan

.........................
 1PGA based 05

Figure 16 SAE/SAN-400 module connection with version A GNSS module diagram
The operating steps for connecting Version B GNSS option to the SAE/SAN-400 series
instrument are as follows:
1. Complete the instrument connection and external GNSS antenna connection following
Steps 1 and 2 of Version A;
2.  GNSS External Power Supply: Use a Type-C cable to connect the GNSS module's Interface
7 to the power adapter, and plug it into the socket;
3. Reference Clock Connection (for High-Quality Modules Only): Instrument MMXC Interface
4 -> GNSS Module MMCX Inteface 10 (using a dual-head MMCX cable).
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Figure 17 SAE/SEN-400 Module Connection Diagram for Version B GNSS Module

6.3.2 SAM/SAN Series

The operating steps for connecting Version A GNSS option to the SAM/SAN series instrument

are as follows:

1.

Instrument Connection: Instrument No.6 AUXIO interface -> GNSS module No.8 AUXIO
interface (with AUXIO to Type-C and Ribbon Cable), GNSS module indicator light blinks
that the connection is successful.

External GNSS antenna connection: antenna -> GNSS module 1 interface (with MMCX to
SMA cable), antenna receiving surface towards the unobstructed sky.

GNSS external power supply (high-quality module only): Use a Type-C cable to connect the
GNSS module's No. 7 connector to the power adapter and plug it into an outlet.

Reference clock connection (high quality module only): MCX connector No. 4 of the
instrument -> MMCX connector No. 10 of the GNSS module (with MCX to MMCX cable).

Figure 18 SAN/SAM module connection with version A GNSS module diagram

The operating steps for connecting Version B GNSS option to the SAN/SAM series instrument

are as follows:

1.

Complete the instrument connection and external GNSS antenna connection following
Steps 1 and 2 of version A;

GNSS External Power Supply: Use a Type-C cable to connect the GNSS module's Interface
7 to the power adapter, and plug it into the socket;

Reference Clock Connection (for High-Quality Modules Only): Instrument MCX Interface
3 -> GNSS Module MMCX Inteface 10 (using an MCX-to-MMCX cable).

Spectrum Analyzer Quick Start Guide 26



Figure 19 SAN/SAM Module Connection Diagram for Version B GNSS Module

6.3.3 All-New SAN Series

The all-new SAN series instruments are equipped with a built-in GNSS module. During use, an
external GNSS antenna (with the receiving surface facing an unobstructed sky) should be
connected to interface 2 of the instrument.

6.3.4 NX Series

The NX series instruments have built-in GNSS modules. To use them, you only need to connect
the antenna, and the receiving side of the antenna is facing to the unobstructed sky. The
procedure is as follows:

1. NXE/NXN-400 series: Antenna -> Instrument 4 GA interface (with MMCX to SMA cable).
2. NXM/NXN series: Antenna -> Instrument 5 GA interface (with MMCX to SMA cable).

6.3.5 PX Series

The PX series instruments have built-in GNSS modules. To use them, you need to connect an
external GNSS antenna (with the receiving side facing the unobstructed sky) to the instrument's
No. 14 GAinterface via the MMCX to SMA cable.

6.3.6 PXZ Series

PXZ series instruments have built-in GNSS module, when using the external GNSS antenna
(receiving side towards the unobstructed sky) through the MMCX to SMA cable connected to
the instrument's No. 3 ANT port.

6.4 Connection of External GNSS Module

6.41 SA / NX Series

Connect the instrument to the PC via the USB 3.0 interface, and connect the external GNSS

module to the PC’s USB interface using a USB-to-serial cable.

6.4.2 All-New SAN Series

External GNSS module connection is not supported.

6.4.3 PX Series

External GNSS module -> Instrument Interface 4 (using a USB-to-serial cable).

6.4.4 PXZ Series
External GNSS module -> Instrument Interface 7 (using a USB-to-serial cable).
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7. Using the Accompanying Trigger Board

This chapter explains how to connect and use the accompanying trigger board on SA, NX, and

PX series instruments, including trigger input/output and 10MHz reference clock output

functions.

71 Interface Overview

7.1.1 Introduction to the Trigger Board for SA/NX/PX Series

e

Figure 20 SA/NX/PX Series Accompanying Trigger Board Interface Diagram
Table 16 SAN and SAM Series Interface Description

Pin Name Direction
1 TRGIO1 I
2 TRGIO2 /
3 TRGO/103 @)
4 LFADC /
5 LFADC /
6 G-3V3 @)
7 G-U9TX /
8 G-DLREF /
9 REFOUT ©)
10 AUXIO /
1 G-U9RX /
12 G-RFLO /

Level Standard

3.3V
/

3.3V

Meaning

Trigger Input
Reserved

Trigger Out
Reserved

Reserved

Power Output, 3.3V
Reserved

Reserved

Reference clock output
for 10 MHz standard
clock signals
Multi-Function Port

Reserved

Reserved
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13 G-IFLO / / Reserved

7.1.2 Introduction to the Trigger Board Interfaces for the PXZ Series

-— @

—

3 —
I ! ... ’

—_— N

! = 2

. -

4111

Figure 21 Description of the Trigger Board Interfaces for the PXZ Series
Table 17 Description of the Trigger Board Interfaces for the PXZ Series

Pin Interface Name Description

1 Type-C Connected to the multifunction AUXIO port of the PXZ
multifunction port Series.

2 14-pin For a detailed description, please refer to Table below.

multifunction port
Table 18 Description of the 14-pin Multifunction Port (Orientation from Left to Right)

Pin Name Direction Level Standard Meaning

1 TRG_IO1 I 3.3V External Trigger Input
2 TRG_IO2 / / Reserved

3 TRGO/103 @) 3.3V Trigger Output

4 GND / / Ground

5 UARTL_IT / / Reserved

6 3V3DIN O / Power Output, 3.3V

7 UART_RX / / Reserved

8 GND / / Ground

9 UART_TX / / Reserved

10 NC / / Reserved

1" NC / / Reserved

12 NC / / Reserved

13 GND / / Ground

14 REFOUT O / Reference clock output

for 10 MHz standard
clock signals
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7.2 Connection Diagram

7.21 SAE/SAN-400 Series

1. Connect the ribbon cable: Instrument AUXIO interface No.5 ->14-pin ribbon cable.
2.  Connect the trigger board: 14-pin ribbon cable -> Trigger board multifunction port No.10.

Soaay  SAN-400 o

@ @ & (®) Realtime Spectrum Analyzer

@ (® FPGA based DSP

Figure 22 SAE and SAN-400 Series Instruments Connection to External Trigger Module
7.2.2 SAN/SAM Series
1. Connect AXUIO multifunction to Type-C: Instrument AUXIO interface No.6 -> AUXIO to
Type-C adapter;
2.  Connect the ribbon cable: AUXIO to Type-C adapter ->14-pin ribbon cable;
Connect the trigger board: 14-pin ribbon cable -> Trigger board multifunction port No.10.

SAM-GO M3 E3GH2

8 Rual-Time Spectivm Analyiase
N FPGA based DSP

Figure 23 SAN/SAM Series Instruments Connection to External Trigger
7.2.3 All-New SAN Series

1. Connect the ribbon cable: Instrument AUXIO Interface 8 ->14-pin ribbon cable
2. Connect the trigger board: 14-pin ribbon cable -> Trigger Board multifunction Port 10
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SAN-90

9 kHz-9 GHz

Figure 24 Connection Diagram of SAN Series with the Companion Trigger Board

7.2.4 NX Series

The trigger input/output interface of NX series instruments is located at the MMCX (F) port on

the instrument and is not integrated into the AUXIO port. The 10MHz reference clock can be

output via the multifunction AUXIO port with the trigger board. The specific connection method

is as follows:

1. NXE/NXN-400 series: Instrument AUXIO interface No.3 -> 14-pin ribbon cable -> Trigger
board multifunction port No.10;

2.  NXM/NXN series: Instrument AUXIO interface No.9 -> 14-pin ribbon cable -> Trigger
board multifunction port No.10.

7.2.5 PX Series

The trigger input/output of PX series instruments is located at the MMCX (F) port on the
instrument and is not integrated into the AUXIO port. The 10MHz reference clock can be output
via the multifunction AUXIO port with the trigger board. The connection is as follows:
Instrument AUXIO interface No.8 -> 14-pin ribbon cable -> Trigger board multifunction port
No.10.

7.2.6 PXZ Series

Connect AUXIO multi-function to Type-C: Instrument AUXIO Interface 5 -> Trigger Board
multifunction Port 1.
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8. Reference Clock Input and Output

This chapter describes how to use the reference clock input and output function on SA, NX, and

PX series instruments.

8.1 Reference Clock Input

8.1.1Hardware Connection

N ok~ abd s

SAN/SAM Series: Reference clock source -> Instrument MCX (F) Interface 3.
SAE/SAN-400 Series: Reference clock source -> Instrument MMCX (F) Interface 4.
All-New SAN Series: Reference clock source -> Instrument MMCX (F) Interface 5.
NXN/NXM Series: Reference clock source -> Instrument MCX (F) Interface 1.
NXE/NXN-400 Series: Reference clock source -> Instrument MMCX (F) Interface 7.
PX Series: Reference clock source -> Instrument MMCX (F) Interface 13.

PXZ Series: Reference clock source -> Instrument MMCX (F) Interface 4.

81.2 Software Operation

In the main settings area of the software, click "System" -> "RefCLKSource", select "External",
and set the "RefCLKFreq" to 10 MHz.

File Mode System Preset Single ®Rec PPy [3 [

Ref: 0dBm RBW: 300kHz VBW: 3MHz
Play Back

System

Previous

Center: 10.010004GHz

Figure 25 Setting the External Reference Clock Source

8.2 Reference Clock Output

8.21

1.
2.

Hardware Connection

SAN/SAM Series: No reference clock output function.

SAE/SAN-400 Series: Connect the instrument to the companion trigger board; Trigger
Board MMCX (F) Interface 9 -> Instrument requiring the reference clock.

All-New SAN Series: Instrument MMCX (F) Interface 6 -> Instrument requiring the reference
clock.

NX Series: Connect the instrument to the companion trigger board; Trigger Board MMCX
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(F) Interface 9 -> Instrument requiring the reference clock.

5. PXSeries: Connect the instrument to the companion trigger board; Trigger Board MMCX (F)
Interface 9 -> Instrument requiring the reference clock.

6. PXZ Series: Connect the instrument to the companion trigger board; Trigger Board 14-pin
Multi-function Interface 2 -> Other series companion trigger board (via 14-pin ribbon cable);
Other series companion trigger board MMCX( F) Interface 9 -> Instrument requiring the
reference clock.

8.2.2 Software Operation

In the main settings area of the software, click "System" and enable "RefCLKOut".

File Mode System Preset Single ®Rec P Play a ; O X

Ref: 0dBm RBW: 300kHz VBW: 3MHz 11:08:26

26r01700 | Retum Play Back

Ri
Graph
Trace

Search

Marker p

%
®

Previous
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9. Analog IF output

9.1 Output Intermediate Frequency Signal

1. Connect the signal generator to the instrument's RF input interface, with the signal
generator outputting a1 GHz, 0 dBm signal;

2. Switch the software to Receiver/IQ Stream mode, ensuring that the instrument outputs a
stable intermediate frequency (IF) signal;

3. Output the IF signal generated by the instrument to other measuring instruments for
viewing through the following interface.
= SAE/SAN-400 Series: Interface 2
= All-New SAN Series: Interface 7
=  NXE/NXN-400 Series: Interface 9
» PXSeries: Interface 10

9.2 Viewing the Intermediate Frequency Signal

1. The frequency of the simulated intermediate frequency output signal is between about
307.2 MHz + 50 MHz, with a maximum output power of -25 dBm and an output impedance
of 50 Q. The center frequency of the simulated IF output for each instrument can be found
in the IF calibration file within the "/bin/CalFile" folder of the instrument's software directory;

>| bin > CalFile Q

@
5]
2
Il
B8

a 023_31325119002f0048 _ifacal.txt x +

| 023_31325119002f0048 _ifacal.txt L
H ~

iii
¢

B 7 e &

023_31325119002f0048 rfacal. bt -
*IFGain_Temperature T2 7065

#IFGain_TO IFGain_T1  IFGain_T2

-5.9452209 -5.9013367 -5.8278503
-3.0675659 -3.0348511 -2.9972382
0.0000000 0.0000000 0.0000000
27121582 27104187 2.7222595
-5.2869873 -5.4354706 -5.5233002
-2.4459991 -2.6260071 -2.7194672
0.6052094 0.4045868 0.2654266
3.3336792 3.1477203 3.0146484

d 20790000000 0 0 0 0 O
*IF2ZNDFrequency 311000000 305000000 0 O

*IQsampleRate 122880000
*IF1STBandNumber 2
e A

AR IR IRl

023_3332511000320029 _ifacal.txt

023_33325110003e0029 _rfacal.tet

[ 023_373033383332511000320029_demodylic

B 023_373033383332511000320029_pulsedeljlic

Figure 27 View the simulated intermediate frequency output frequency points
2. Set the "Center Frequency" of the measuring instrument to 311 MHz (refer to the
corresponding calibration file for the specific value), and keep the other parameters at their
default settings. Then, view the intermediate frequency output.
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Figure 28 View the intermediate frequency output signal.
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10. GPIO Usage Instructions

This chapter describes how to connect the EIO expansion board to the all-new SAN series
instruments and control the output levels of the various GPIO interfaces.

10.1 EIO Expansion Board Interface Description

Figure 29 EIO Expansion Board Interface Description
Table 19 Pin Description of the EIO Expansion Board Interface

Pin Description

1 GPIO0
GPI1O2

N

GP104
GPIO6
GND

GPIO1
GPIO3
GPIO5

© 0 N oo g ~ AN

GPIOT7

10.2 EIO Expansion Board Connection

EIO Expansion Board 14-pin Interface -> All-New SAN Series Instrument AUXIO Interface 8.
After connection, click "System" ->"GPIO" in the software menu bar to control the output levels
of the different GPIO interfaces.
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11. Modify the IP address of the NX-Series
instrument

Go to the official website of HAROGIC (https://www.harogic.com/setdeviceipaddr-2/) to
download and extract the "SetDevicelPaddr.zip "folder to your desktop or other directory.

111 Obtaining NX-Series Instrument IP Addresses

1.
2.

3.

Default IP address: "192.168.1.100" (not modifiable), "192.168.3.100" (modifiable).
Instruments through the direct connection or access to the router, to ensure that and the
host computer in the same network segment.

Run "SetDevicelPaddr\SetDevicelPaddr.exe" to check the IP address of the instrument.

11.2 Modifying NX-Series Instrument IP Addresses

11.2.1 Notes on IP modification

1.

To ensure that the IP of the receiver network card and the host computer other non-physical
connection of the network card's IP address is in a different network segment, in order to
avoid network conflicts.

IP address cannot end with ".0", "1" or ".255", these addresses have a special purpose in the
network (such as network address, broadcast address or gateway address), the use of
them may lead to communication anomaly ), and their use may lead to communication

anomalies.

11.2.2 IP Modification Procedure
Run "SetDevicelPaddr\SetDevicelPaddr.exe".

1.

2.

Single instrument

» Enterthe IP address (in standard format, e.g., 192.168.3.101)

» Enter the subnet mask (CIDR format, e.g. 255.255.255.0)

» Press the Enter key to execute the modification, and the prompt "Change ip address
successfully" indicates success

Number of current devices : 1
Local IP : 192.168.1.101 Local Mask : 255.255.255.0

Device Number: @

UID : 4248500a001960020

IP : 192.168.3.100
.255.255.0

Pleas nput a new IP address : 192.168.1.3

Please input a new subnet mask : 255.255.255.0

Change ip address successfully

Whether to continue 7 (y to continue to change ip address or enter any key to exit)

Figure 30 Single NX Instrument Modification IP
Multiple instruments
=  Enter the instrument numbers in sequence (each instrument corresponds to a unique
Device Number, take the instrument with UID 33325110003e0029 as an example)
= Enterthe IP address and subnet mask (in the same format as above)
» Press the Enter key to execute the modification, and the prompt "Change ip address
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successfully" indicates success

Number of current devices : 2

Local IP : 192.168.1.101 Local Mask : 255.255.255.0
Device Numbe 0]

UID : 33325116004d00k4e

IP : 192.168.100.66

Mask : 255.255.255.0

Device Numbe:

UID : 42u8500a00190020

IP : 192.168.1.3
255.255.255.0

Please input "Device Number" that needs to be configured :

Please input a new IP address : 192.168.1.4

Please input a new subnet mask | 255.255.255.0

Change ip address successfully

Whether to continue ? (y to continue to change ip address or enter any key to exit)

Figure 31 IP modification for multiple NX instruments
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12. PX Remote Control Guide

121
1.

Network port direct connection
Connect the driverless docking station with network port to the USB 3.0 interface (USB3)
on the upper panel of the instrument, and connect it to the network port of the computer
or embedded instrument via a network cable. Note: USB1 and USB2 are USB 2.0 interfaces,

it is recommended to use the USB3 interface in preference for better performance.

Figure 32 External drive-free docking station with network port
Exit the current host computer software, enter the PC "Settings -> Network and Internet ->
Properties", manually configure the IPv4 address (such as "92.168.1.2") and subnet mask
("255.255.255.0"), ensure that the same network segment as the instrument IP
("92.168.1.100"), and the instrument IP ("192.168.1.100"). "255.255.255.0"), make sure that it is
in the same network segment as the instrument IP ("192.168.1.100").

Edit IP settings

& [vea ] |
\

IPv4 :
Find a setting —onl
€} Home P address »
- 19216812 « ; |

stem
% connected to this Off @
9 Bluetooth & devices Subnet mask
| ¥ Network & internet 2552552550

/ Personalization o ‘ N

Figure 33 Configuring IP Addresses and Subnet Masks
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3. Through the cmd execution "ping 192.168.1.100" to verify network connectivity.

== C\WINDOWS\system32\cmd. X il

Microsoft Windows [Version 10.0.22631.4037]
(c) Microsoft Corporation. All rights reserved.

C:\Users\10418>ping 192.168.1.100

Pinging 192.168.1.100 with 32 bytes of data:

Reply from 192.168.1.100: bytes=32 time<lms TTL=64
Reply from 192.168.1.100: bytes=32 time<lms TTL=64
Reply from 192.168.1.100: bytes=32 time<lms TTL=64
Reply from 192.168.1.100: bytes=32 time<lms TTL=64

Ping statistics for 192.168.1.100:

Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),
Approximate round trip times in milli-seconds:

Minimum = Oms, Maximum = Oms, Average = Oms

Figure 34 Test instrument network connectivity (ping command)
4. Double-click to open the PC host software directory "configuration\Settings.ini" file, set
Interface = ETH;
5. 5. From the userdata folder on the desktop of the instrument, enter the "/bin/CalFile" path
of the software to get the calibration file and save it to the "\bin/CalFile" directory of the
corresponding software on the PC.

[} calFile v o
Eile Edit View Bookmarks Go Tools Help

.« O~ © /2 |/mediajrpdzkj/userdata/ /bin/CalFile |f§'

Places v
A% Home Folder

B Desktop 023_424850 023_424850 023_424850 DLO752_am
pr . 12003b003 12003b003 12003b003 pcomp.txt
[ Trash Can 0 confighxt O ifacal.txt O rfacaltxt

=
= Applications

userdata a
_ 16 GB Volu... &,

Figure 35 Obtaining Instrument Calibration Documentation
6. Start the executable programme in the "/bin" folder in the software directory of the PC to
achieve remote control of the PX series instruments.
i. Note: The instrument and the PC software cannot be switched on at the same time.

Figure 36 Direct Ethernet Connection for Remote Control of PX Instruments
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12.2 LAN connectivity
Connect the driver-free docking station with network port to the USB 3.0 interface (USB3)

1.
on the upper panel of the instrument, and connect it to the network port of the router
through the network cable. Note: USB1 and USB2 are USB 2.0 ports, it is recommended to
use the USB3 port in preference for better performance;
Figure 37 Connecting the Router to the Instrument
2. Click the menu bar "File" -> "Exit", exit the software interface in the instrument;
3. Click "userdata" -> "Tools" -> "Open Current Folder in Terminal";
File Edit View Bookmarks goDﬂelp
Lo~ 0o Q‘m- Open Current Folder in Terminal F4i
= = —— \ Find Files... Shift+Ctrl+F
:;C::me o Y i 4% Run a Command in Current Folder...
M Desktop 1111.png 1112.png install.sh picture.sh
1_ Trash Can

EE‘I Applications

_15GBVolu... &

Figure 38 Open terminal

4. In the terminal, type "ifconfig" query the current router to the IP address assigned to the

instrument, in this case, the IP address is "192.168.31.55";

File Edit Tabs Help

Figure 39 Query the dynamic IP acquired by the instrument
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Connect the PC to the same router via Wi-Fi to ensure that it is on the same LAN as the
instrument. Double-click to open the "configuration\Settings.ini" file in the directory of the
PC host software, set Interface = ETH, Address ="192.168.31.55 "

For the next steps, please referto step 5 to step 6 of the chapter on the Network port direct
connection.

o

Figure 40 Remote control of PX instruments by LAN

12.3 OTG Connection

1.

3.

Connect the instrument's USB 3.0 interface (USB3) to the host computer's USB port using a
USB cable;

Click "File" -> "Exit" in the menu bar to return to the instrument's desktop. Click the "OTG"
icon on the desktop, and after the window pops up, observe the content of the window:

If the window displays "OTG is enabled," manually restart the instrument

If "OTG is disabled" appears, close the pop-up window, click the "OTG" icon again, and then
manually restart the instrument

Figure 41 Check the OTG startup status
Referto Steps 2to 6inthe Network port direct connection section to configure the network
and remotely control the instrument.
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